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LEGAL

All software discussed in this manual is issued as is and the software described in this manual 
comes with no warranty. We are not be responsible for any lost data, hardware problems or 
financial loss incurred as a result of using this software. If you are unsure as to how to use this 
software, don’t use it. Any information in this manual is subject to change without notice and 
nothing in this document represents a commitment on the part of Twisted Tools, LLC.  All the 
software described by this document is copyright Twisted Tools. All product names and company 
names mentioned herein are ™ or registered trademarks of their respective owners. The software 
described by this document is subject to a License Agreement and may not be copied to other 
media. Click here to view the complete End User License Agreement online for this product online 
and read before using the included software or sample content. You may not alter this document in 
any form or distribute it for any purpose other than press related purposes. You may not share this 
software with anyone or any entity, such as torrent sites without violating the terms of use. Should 
you share this software illegally, it is likely that the wrath of god will come down upon you.  Should 
you buy this software, your karma will be plentiful. 

If you somehow magically obtained this software, buy it...at our site.  We need your support to 
keep bringing you more twisted tools. 

Twisted Tools™

San Francisco, CA

USA
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TWISTED TOOLS | MSMAX
USER GUIDE

1. Welcome
Thanks for purchasing MSMAX. We hope you enjoying using this tool as much as we 
enjoyed making it!

MSMAX is a Maximizer effect and Mid/Side utility built for Native Instruments Reaktor.  

As a Maximizer, MSMAX can be used for anything from subtle to extreme loudness 
maximization to get individual tracks or mixes sounding loud and finalized. As a Mid/Side 
matrix, MSMAX can be used to encode, decode and process Mid/Side signals to add 
width or create stereo imaging effects. 

Whether you use MSMAX to slam your drum bus, apply creative M/S techniques within 
Reaktor or squeeze some more volume out of your master, we hope you’ll find MSMAX to 
be a versatile tool with several tricks up its sleeve.

Have fun!

Twisted Tools

1.1. Manual Conventions
This manual uses formatting conventions to point out facts, teach you tips and warn you of 
things.  

The following icons are found throughout this guide:

Important warnings. Always read these!

Notes: Useful notes and relevant additional information.

Tips: Tips and advanced techniques. 

Videos: Links to relevant videos.

Audio: Links to relevant audio.

           Welcome
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Links: Links to other content/websites with relevant info.

Single step instructions will be indicated with an arrow like the one on the left.

The following text formatting is used throughout this guide:

Text appearing in menus (New, Save, etc.) and file paths and file names will be Italic.
Text appearing somewhere on the interface, but not in a main Reaktor menu will be 

highlighted in BLUE. 

Important names, ideas and topic headings will be bold.

Key commands will be in brackets (e.g., “Press [Control]”)

Section links (e.g., links to other sections within the manual) will be indicated like 

this.

1.2. System Requirements
Mac or PC running the full version of Native Instruments Reaktor 5 (5.8 and up). 
Intel Core 2 Duo Processor or better recommended
500MB of RAM
iPad with Liine Lemur if using the included Lemur template

http://liine.net/en/products/Lemur

           Welcome
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1.3. Installation
MSMAX is a Reaktor ensemble. There is no need to 
install a Reaktor ensemble. They are like Word 
documents, you can put them anywhere and double-
click them to open them or drag them to the Reaktor 
interface to open them.

That said, it is good practice to put them somewhere 
in your default Reaktor USER CONTENT location, 
which you can set in Reaktor > Preferences, within 
the DIRECTORIES tab.

Files that say .ENS should be put in the Ensembles 
sub-folder in your user library. Then you can easily 
browse for them from within the Reaktor browser 
window's user tab.

Files that say .ISM should be put in the Instruments 
sub-folder in your user library. Instruments are the 
main components in an ensemble. 

In most cases, you will want to always use a .ENS file which is finished and ready to use, 
whereas .ISM files are mainly used for building.

            Installation
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2. What is MSMAX
MSMAX is a Maximizer effect and Mid/Side utility built for Native Instruments Reaktor.  

As a Maximizer, MSMAX can be used for anything from subtle to extreme loudness 
maximization to get individual tracks or mixes sounding loud and finalized. As a Mid/Side 
maxtrix, MSMAX can be used to encode, decode and process Mid/Side signals to add 
width or create stereo imaging effects.

With near-zero latency and CPU efficient code, you can use it on any type of track and run 
multiple instances without bogging down your system.

MSMAX also features a flexible and easy to use insert effects path, that allows you to insert 
your own effects to be applied to either the Left/Right or Mid/Side signals. To get you 
started, we’ve included an example effect called Nanoverb, which allows you to apply EQ 
and/or Reverb to any channel.

Lastly, MSMAX has a Sidechain Ducker at the output stage for some volume ducking or 
pumping effects. There are several modes to choose from to achieve instant results. For 
example, setting the Sidechain Ducker to auto mode will produce a 1/4 note pumping 
effect. Set it to ‘Self’ mode and you can duck a delay on a vocal track using the vocal itself 
as the sidechain input.

MSMAX comes bundled with an iPad *Liine Lemur OSC template by Antonio Blanca to 
control it remotely using your iPad. 

*Reaktor Player is NOT Supported. 

*Liine Lemur app not included.

http://liine.net/en/products/Lemur

2.1. How is it designed to work?
MSMAX is essentially a loudness normalizer that works by limiting the peaks in your signal 
at 0dB and then raising the volume of the signal below the peaks up towards 0dB as well. 
Doing so creates a perceived increase in volume or loudness. 

MSMAX works on stereo, mono or M/S signals at the input and outputs either stereo, 
mono or M/S signals at the output. In most cases, you’ll use Stereo In and Stereo Output if 
you’re using MSMAX to process your stereo bus.  

What is MSMAX?
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2.2. What is M/S?
M/S stands for Mid/Side and refers to a common technique used in both recording and 
mastering to alter your stereo image, typically with the goal of making sounds wider or 
narrower.

A Mid/Side signal is an encoded stereo signal that is made up of two channels, Mid and 
Side. The Mid channel is a mono sum. It is the signal that is the same on both the left and 
right (L+R). The Side signal is the difference (L-R) and is basically what makes a stereo 
signal have width. If you remove a Side signal, you’re left with just the Mono elements 
(Mid).  If you boost the Side signal, you’ll increase the difference between left and right 
making the stereo image wider. 

By encoding a Left/Right signal into an M/S signal, you end up with Mid signal on the left 
channel and S signal on the right channel. This allows you process the mono and stereo 
information of the signal independently. Once you’ve processed the channels (gain, eq, 
reverb, etc.), you decode them back to a standard stereo signal. The result is a normal 
standard stereo signal whose Mid/Side information has been manipulated independently. 

MSMAX doubles as a handy conversion matrix that allows you to use a standard stereo 
signal and encode it into M/S (choose LR>M/S at the input) or use an already encoded M/
S signal at the input. Once encoded, you can process the Mid/Side signals independently 
using the Maximizer and/or an insert effect of your choosing.  This opens up a wide range 
of possibilities when using Reaktor’s factory library or user library and we encourage 
experimentation. We’ve included a Reverb and EQ called NANOVERB to get your started 
experimenting. 

Try adding Reverb to just the ‘Sides’ to get a wet and wide sound without getting in the 
way of important stuff you have going in the center channel, like kicks, snares and vocals. 

Keep in mind, that by applying processing to just the sides alone, it won’t be there when/if 
you choose to listen to your song in mono! If mono compatibility is important to you, use 
side processing with caution. 

2.3. MSMAX Feature Highlights
Stereo Maximizer
Flexible Mid/Side Matrix (Encode/Decode)
Sidechain Volume Ducker (Sidechain using: Audio, MIDI, Auto, Self)
Insert effects path (Pre/Post Maximizer)
Output Limiter
Mono Summing

What is MSMAX?
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Dry/Wet Mix with internal latency compensation
Near-zero Latency (1 sample)
Low CPU
Phase flip (Standard or Pre-Decode M/S for 180 degree flip)
Nanoverb Example Insert(Reverb and EQ)
Switchless switching for instant A/B’ing settings without clicks or pauses

What is MSMAX?
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3. Getting Started with MSMAX
The following sections will give you a very quick overview of how to get going with 
MSMAX. We will explain how to open MSMAX and how to explore and use the default 
factory Snapshots (presets).

For more detailed information on working with Reaktor snapshots, please read the 
Application Reference manual that comes with your Reaktor application. 

Be sure to turn on EDIT mode by clicking the structure icon next to the main snapshot 
menubar. Otherwise, you won’t be able to create your own snapshots.

3.1. How to Open MSMAX

To open MSMAX:

1. Start Reaktor in standalone mode or plug-in mode. 

2. In Reaktor’s file browser (View > Show Browser), click on USER tab. 

If you didn’t install MSMAX into your User Library, you can navigate to MSMAX.ens using 
the ‘Disks’ tab, go to FILE>OPEN an launch MSMAX or simply drag and drop the 
MSMAX.ens onto the main Reaktor window from its location on the hard drive.

3. Double-click (or drag) MSMAX.ens from the lower section of the browser onto the main 
Reaktor screen area and MSMAX will be loaded and ready to play.

Getting Started
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If you are in standalone mode, you may need to go to File > Audio & MIDI Settings to setup 
your audio and MIDI. If you are in plug-in mode, be sure your track is armed and your audio 
driver is setup.

3.2. Exploring Snapshots

Snapshots

A Snapshot is a preset. You can change a snapshot by using the snapshot drop down in 
the Main Bar . 

3.2.1. Saving Snapshots using the Sidepane

As you work, you’ll make modifications and changes to the Snapshots. Naturally, you’ll 
want to save these. In order to save Snapshots,  you’ll need to be familiar with the Reaktor 
Sidepane area. Be sure to turn on EDIT mode by clicking the structure icon next to the 
main snapshot menubar.

Getting Started
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Fig. 3.1 MSMAX Snapshots.

[1] Sidepane Button
[2] Snapshot drop-down menu
[3] Snapshot Banks 
[4] Snapshots area

First, let’s look at how to select snapshots using the Sidepane:

1. Be sure the Sidepane is open, by clicking the Sidepane Button (1).

2. Next, be sure to select ENS - MSMAX from the Snapshot drop-down menu (2) if it 
isn’t already selected. 

3. Choose a bank of Snapshots that you’d like to listen to from the Snapshot Banks (3).

4. Choose presets from the Snapshots area (4) below.

Getting Started
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The Snaphot drop-down menu you set in step two above, allows you to choose MSMAX’s 
Snapshots, or additional Snapshots for other instruments/effects you may be running inside 
of Reaktor alongside MSMAX.  For example, MSMAX comes with one additional effect 
called, Nanoverb. While it can have its own snapshot banks, it isn’t necessary to create 
Snapshots for it since MSMAX will automatically store those settings when you save 
MSMAX snapshots.

Next, let’s look at the save options. 

At the bottom of the Snapshots area, you will see three buttons: APPEND, STORE and 
INSERT.  

APPEND: Creates a Snapshot in the next available free slot. 

STORE: Stores Snapshots by overwriting the current Snapshot.

INSERT: Inserts Snapshots in between other Snapshots, in a slot within any bank that you 
choose. 

Be sure you have ‘Ens - MSMAX’ selected in the Snapshot drop-down menu. We 
recommend turning ‘Linked’ off to avoid confusion.  Linked will automatically select the 
Snapshot drop-down menu to be set to the last instrument you clicked.

3.2.2. Snapshot Banks Described

There are plenty of Snapshots to help get you started with MSMAX. There are several 
banks of Snapshots included with MSMAX to demonstrate all the possibilities out of the 
box. Keep in mind, depending on your signals levels and characteristics, these presets are 
intended as a starting point and you will need to adjust them.

MSMAX’s Snapshot Banks are organized into the following categories:

MASTER - Effects intended to be applied to a Master bus or Subgroup
INSTRUMENTS & VOCALS - Effects designed for use with particular instrument 
types.
MID/SIDE & STEREO IMAGE EFFECTS - Effects that showcase the use of the M/
S matrix to alter the stereo image your signal. 

These effects are setup to use standard LR signal at the input and convert to M/S and 
back to Stereo at the output.

SIDECHAIN - Effects that take advantage of the Sidechain Ducker effect at the 
output stage. 

Getting Started
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Using SC or MIDI mode will require additional setup, therefor the default presets are set to 
‘AUTO’ mode by default. Use the Settings icon to access the Sidechain modes.

BASIC ROUTING - Effects that showcase the use of the M/S matrix to convert 
signal types.

You can easily export and share your Snapshot banks. To export and save your Snapshots 
(without the samples), simply click the ‘Edit’ menu in the Snapshots Banks area.

Getting Started
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4. Overview of MSMAX
In this section of the manual, we’ll examine the interface, look at basic signal flow 
principles and explain all the MSMAX controls. 

We recommend you begin exploring by looking at the Getting Started section to get 
familiar with Snapshots before reading on.

4.1. The Interface

Fig. 4.1 MSMAX User Interface.

[1] The Master area: Contains global controls, MIX and BYPASS.
[2] The Wave Display, Meters and Output Settings area: Contains a visualizer 
showing the incoming audio (grey) and processed audio (cyan) and level meters. 
Output Settings are displayed here when clicking the ‘settings’ button in the output 
section. 

            Overview

                                       MSMAX USER GUIDE - PAGE 17



[3] The Input area: Input settings determine the type of signal to be used with 
MSMAX.  
[4] The Effects area: Contains the Maximizer effect settings and the insert effect 
settings. 
[5] The Output area: Determines what kind of signal will be sent out of MSMAX 
(pre-mix). 
[6] The External effect insert: Contains the default example effect (NANOVERB) 
connected to MSMAX’s insert system. This effect can be easily swapped out with 
your own effects at the top level of the Reaktor structure.

4.2. Parameters, Controls and Settings
In this section we’ll look at the parameters and settings you’ll find throughout the interface 
starting with at the top and working our way down.

4.2.1. Master Area Controls

The master section has two basic functions, MIX and BYPASS.

MIX: Adjust the amount of dry signal versus wet signal. Dry signal is untouched, whereas 
Wet signal is signal that has been affected by MSMAX. The Dry/Wet signals are delay 
compensated (1 sample) so that there isn’t any phasing when mixing both signals.

BYPASS: Bypasses MSMAX entirely so that you can quickly audition Dry, unprocessed 
signal.

4.2.2. Using the Input and Output Meters 

MSMAX has input and out meters that are used to identify level arriving at the input (left 
side of the Wave Display) and signal arriving at the output (right side of the wave display).

            Overview
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[Double-Click] The numeric readout above the meter to reset the peak detection

The numbers at the top represent peak levels. Grey digits indicate the highest peak value 
up to 0dB. If signal crossed 0dB the numbers will turn red. The loudest peak will remain 
displayed until you refresh the display back clicking the number displayed at which point 
detection resumes.

A red line in the meter below indicates that signal has hit 0dB.

Keep in mind that if you’re using Reaktor’s built-in default meters, they display Red even 
though signal hasn’t hit 0dB. Use the MSMAX meters for all purposes.

4.2.3. Understanding the Wave Display

The Wave Display

The wave display contains a visualizer showing the incoming audio and also shows the 
Output Settings parameters and controls when clicking the ‘settings’ button in the output 
section. Grey shows unprocessed signal (dry signal that isn’t going through MSMAX) and 
Cyan shows processed signal (signal that has passed through MSMAX).

4.2.4. Input Area Controls

The Global Numeric Readout

Touch any knob or control to see its current value displayed in the global Numeric 
Readout.

In order to have a lean User Interface, we opted to have one universal numeric readout 
that isn’t cluttered with numbers and meters. The Numeric Readout at the top of the Input 
Area will show you all the values of any MSMAX control when it is touched and below 
each knob you’ll see a set of level meters showing you the level at that stage. 

            Overview
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The Input Modes

The input modes determine what kind of signal you are using with MSMAX and that signal 
will be processed.

LR>M/S:  Standard left/right signal arriving at MSMAX is encoded to M/S (Mid-Side) 
signals before being sent to the Effects section. The left channel contains the MID signal 
and right channel contains the SIDE. 

If you use MSMAX in M/S mode, you will end up with a signal that goes over 0dB. Be sure 
to turn on the Output Limiter in the output section to prevent overs if you decide to use 
either M/S mode and are expecting output to not pass 0dB.

LR:   Standard Left/Right signal is accepted and passed through to the Effect section.

M/S:  Pre-encoded mid-side signal arriving at MSMAX is accepted and passed to the 
effect section. 

Use the M/S setting ONLY if you have already encoded your files to M/S somewhere else.

The Input Knobs

The input knobs determine the level of either the Left/Right signal or the Mid/Side signal if 
using either M/S mode. When in either M/S mode, the meter will display M and S 
respectively.

            Overview
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[Double-click] the label to reset the knobs to their default position.

[Shift-Drag] to fine tune your control.

The Input Knob Meters

The input knob meters show the level of the signal at the input stage, after any knob 
adjustments. The loudest peak will remain displayed until you refresh the display back 
clicking the number displayed at which point detection resumes. 

Input knob values are always grey.

Center Panel Input Buttons

BYPASS: Left (Mid) or Right (Side) bypass.

LINK: Links the Left (Mid) and Right (Side) knob amounts.

4.2.5. Effects Area - Insert Controls

MSMAX allows you to insert any Reaktor effect (or external effect) pre or post Maximizer. 
By default, we’ve included the NANOVERB effect which is a Reverb and/or Equalizer, 
though we encourage you to experiment with your own effects.

The Insert Controls

BYPASS: Left (Mid) or Right (Side) bypass.

POST: Routes the insert effect so that it takes place after the Maximizer, rather than before 
the Maximizer which is the default behavior. 

LINK: Links the Left (Mid) and Right (Side) knob amounts.

            Overview
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If you do set the Insert to POST, you will end up with a signal that goes over 0dB. Be sure 
to turn on the Output Limiter in the output section to prevent overs if you decide to use an 
insert in Post mode. 

4.2.6. Effects Area - Maximizer Controls

The Maximizer Controls

The Maximizer has three controls for either the Left (Mid) or Right (Side) signals. By using 
the LINK button in the Maximizer’s center panel, you can link the controls on both the left 
and right sides. 

In standard LR mode, if set to LINK, the threshold's for both the left and right sides will be 
used together. If unlinked, the threshold detection for each side is independent and is a 
nice way to get some subtle stereo imaging effects.

Hold shift to fine tune adjustments.

(A)TTACK: Attack time for Left or Mid signal of the Maximizer.  In most cases you'll want to 
leave this at 0 if you're looking to limit your signal at 0dB without overs.  In some cases, if 
you're after a more gentle Maximization, you can adjust this above zero.

(R)ELEASE: Release time for the Left or Mid signal of the Maximizer. A good default setting 
is 100ms.  If you'd like a more agressive sound, set a shorter release time. If you'd like a 
more natural limiting effect, set a longer release time.  Shorter release times will result in 
more artifacts and distortion, which can also be used for effect.

AMOUNT: Controls the amount of Maximization for the Left or Mid signal. The cyan color 
ring, indicates the amount you are gaining up the signal. The numeric display below will 
show grey digits until the signal crosses 0dB, at which point the digits will turn blue. The 
grey ghost ring indicates how much Maximization is taking place above 0dB. 

            Overview
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In the above example, there was a signal with 6dB arriving at the input. We gave it 3dB of 
gain with the amount knob and the result is 9dB of maximization.

Center Panel Maximizer Buttons

BYPASS: Left (Mid) or Right (Side) bypass.

LINK: Links the Left (Mid) and Right (Side) knob amounts.

In standard LR mode, if set to LINK, the threshold detection is linked. If unlinked, 
the threshold detection for each side is detected independently and can be used to 
get some subtle stereo imaging effects. We recommend leaving LINK on for most 
purposes where standard volume maximization is desired.

In either M/S mode, the detection is always unlinked as it should be.

4.2.7. Output Area Controls

The MSMAX Output Area has several additional features and controls related to the output 
stage of the processor. 

The Sidechain Controls

The Sidechain Ducker (SC) is a Volume ducker that is post Maximizer and can be set pre 
or post mix in the Output Settings. The volume envelope of the Sidechain signal (set below 
the SC Monitor in the Output Settings Area) is used duck the volume of the MSMAX signal 

            Overview
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at the output. You can use the Sidechain Ducker to create ‘pumping’ or ‘ducking’ effects 
where the entire MSMAX signal lowers in volume based on the Sidechain signals envelope.

SC: Activates the output stage Sidechain Ducker. 

Additonal Sidechain settings can be accessed by clicking the Output Settings icon.

The Wave Display Area at the top of the screen will become the Output Settings Area with 
several controls for the Sidechain Ducker.

AMT: Determines the amount of volume ducking that takes place. If set to 0 no ducking 
will take place, if set to 100 the maximum amount of ducking will take place (up to -96dB).

REL: The envelope detection smoothing factor. A faster release means more accurate 
detection of the SC signal, but a more 'shakey' sound. A longer release will result in 
smoother volume ducking.

LP: The Sidechain Ducker LP control is a Low Pass filter for the sidechain detection signal. 
For example, with an LP setting of 100Hz you can filter out everything except for the bass 
frequencies in loop being used as a Sidechain signal, so that just the Kick triggers the 
volume ducking to occur.

MODE: The Sidechain Ducker can be set to be PRE or POST MIX. If Pre-Mix, only the 
Maximized/Processed signal will be ducked. If Post-Mix, both the dry signal and wet signal 
will be ducked by the Sidechain Ducker.

SC MONITOR: The Sidechain Monitor shows the detected Sidechain Input signal. 

There are several Sidechain Input modes to choose from.
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SC - In this mode, the sidechain audio signal from Reaktor Inputs 3-4 are used to duck the 
volume. 

If you look inside the instrument structure at the top level you will see inputs 3-4 connected 
to the sidechain. These are the inputs that MSMAX uses when set to SC mode. It will take 
audio from your host’s sidechain path (when using Reaktor as an insert effect) and connect 
it to the MSMAX sidechain. You can easily disconnect these and connect another Reaktor 
instrument or drum Maschine to the SC inputs if you prefer to use Reaktor as the SC 
source. 

MIDI - MIDI note input is used to duck signal. Note On events cause the volume on the 
signal to duck.

In some DAWS, such as Logic pro, this will mean setting up MSMAX on an Instrument 
track so that you can route MIDI notes to it. 

AUTO - A 1/4 note pulse is used to automatically duck signal. No Sidechain audio setup is 
required.

SELF - The input signal at Reaktor inputs 1-2 is used to duck signal. 

Self mode means that the very same signal you are ducking, causes the ducking! Why 
would you want to do that? Well, for example you may wish to route a vocal to a delay and 
duck the delay every time your vocal is active, so the vocal and the delay never clash. You 
can do this by setting MSMAX to Mix 50%, turning on the SC and choosing SELF. Connect 
a delay to the MSMAX insert path and set the delay effect to 100%. Now every time your 
vocalist sings, the delay ducks down. When they stop singing, the delayed sound will get 
louder.

The Master Limiter and Controls   

MSMAX features an additional output limiter that is intended to be used in situations where 
you may have signal over 0dB reaching the output. In most cases, if you’re using MSMAX 
to maximize a stereo signal, you won’t need to use the Master Output Limiter since 
MSMAX is itself a limiter, however there are scenarios where you will need it.

Example scenarios that may require the Master Output Limiter to be engaged:

M/S Processing and/or M/S Maximizing
Using MIX to blend dry/wet signal

            Overview
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Using an insert set to POST

When the Maximizer’s attack is greater than 0

Activate the Master Output Limiter by clicking the LIMIT button in the output area.

Click the Settings Button in the Output area view the Master Limiter settings.

The Wave Display Area at the top of the screen will become the Output Settings Area with 
several controls for the Master Output Limiter.

REL: Release time for the output limiter. A good default setting is 100ms.  If you'd like a 
more agressive sound, set a shorter release time. If you'd like a more natural limiting effect, 
set a longer release time.  Shorter release times will result in more artifacts and distortion, 
which can also be used for effect.

MODE: If Pre-Mix, only the Maximized/Processed signal will be limited at this stage. If 
Post-Mix, both the dry signal and wet signal will be limited by the Master Output Limiter.

Center Panel Output Buttons

PHASE FLIP: Left (Mid) or Right (Side) flip depending on mode setting found in Output 
Settings.

LINK: Links the Left (Mid) and Right (Side) knob amounts

            Overview
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The Phase Controls

MSMAX offers the ability to PHASE FLIP the processed signal and choose a stage in the 
signal flow that you’d like the phase flip to occur if decoding M/S signal back to Stereo/
Mono. 

Click the Settings Button in the Output area view the Phase Flip settings.

You can set the Phase Flip to occur PRE DECODE OR POST DECODE when converting 
back to Stereo or Mono (Sum) outputs. 

By setting the Phase Flip to PRE DECODE when using an M/S signal, you can solo the side 
signals and put them in phase by flipping 180 degrees.

Output Modes

The processed signal in MSMAX can be output several different ways before being mixed 
on its way out of MSMAX.

MONO (SUM): Stereo signal at the output is summed to Mono. 

If using M/S signal before the output stage, the signal will be decoded back to Stereo and 
then summed to Mono.

STEREO:  Signal arriving at the output will be output as a standard left/right signal. 

If using either MS input mode (LR>MS or MS), setting the output to STEREO will 
ensure that your signal is decoded back to a standard STEREO signal.  

MS: Signal is encoded to M/S at the output stage so that it can be processed elsewhere.
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This is useful only if you'd like to keep your signal setup as Left=Mid and Right=Side. You 
will need to decode the output signal later using MSMAX or another M/S decoding method.

4.3. Using External Insert Effects
MSMAX comes with one external effect called NANOVERB which is connected to 
MSMAX’s insert path and activated in the effects section (pre or post MSMAX). By external 
effects, we mean to say that the effects are not a part of the MSMAX structure itself and 
can be easily replaced.  You can add your own Reaktor effects or choose from hundreds 
of the excellent effects available in Reaktor’s User library.  

Connecting up your own effects to the insert path in MSMAX is a simple matter of jumping 
into MSMAX’s structure and replacing the NANOVERB.

4.3.1. The default NANOVERB effect controls

The NANOVERB is essentially an EQ and REVERB plugin in one interface. You can use the 
EQ and the REVERB or the EQ alone.

LO: Low Shelf EQ to boost or remove low frequencies (pre-reverb).

HI: High Shelf EQ to boost or remove high frequencies (pre-reverb).

SIZE: Size of the reverb space. Set low for a room tone and set high for a more ambient 
sound.

MIX: Dry/Wet mix for the Reverb output.

BYPASS: Turns NANOVERB on/off.

EQ SOLO: Solo’s the EQ and bypasses the REVERB and MIX controls.

4.3.2. Replacing the NANOVERB effect with your own effect

1. Right-click the MSMAX label and choose Show Ensemble Structure.

2. Select NANOVERB [EXAMPLE INSERT].
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3. Hit delete to it.

4. Right-click the background of the Reaktor structure and choose an effect. 

5. Connect up the EXT outputs to the L-R inputs of your effect and then connect the L-R 
outputs of your effect to MSMAX’s EXT inputs.

6. Use the insert Bypass Buttons on the channel that you would like to send to that effect.

Keep in mind that you can try to use different effects for the M and S channels by simply 
connecting two effects instead of one to the each of EXT outputs. The 1st output would be 
your Mid effect and the second output would be your Side effect. You can even daisy chain 
effects for some creative processing adventures.

5. Using Templates to Control MSMAX
MSMAX comes with a *Liine Lemur OSC template by Antonio Blanca. Please see the 
setup instructions in documentation folder contained in the download for OSC setup 
instructions. 

OSC is by far the best method for controlling Reaktor instruments (high resolution control 
and more features) and you can use it while running Reaktor in plugin mode.. Having said 
that, if you prefer to make standard MIDI assignments or don’t own an iPad or Lemur, feel 
free to make MIDI assignments and save your ensemble.

Making MIDI Assignements

Most parameters in MSMAX can be right-clicked to activate MIDI learn. 
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Right-click and move your controller to make an assignment.
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6. Troubleshooting and FAQ
Sometimes you might run into trouble when using MSMAX. In this section we’ll go over 
some of the common issues you might encounter and how to resolve them.

Can I use the Reaktor Player with MSMAX

No, MSMAX requires the full version of Reaktor 5.8 and won’t run with Reaktor 
Player. 

I can’t open MSMAX! I get an error that says “This is not a valid %1% file”

Update your Reaktor using NI SERVICE CENTER application to be sure you’re 
running the latest version. If you’re running an older version of Reaktor, you’ll get 
this message. 

I can’t hear anything.

Are the BYPASS buttons on for the effects you’re trying to hear? 
Is the master BYPASS button on?
Have you accidentally phase cancelled a signal by incorrectly using the Phase Flip 
buttons? 
Have you setup your Audio & MIDI Settings under File>Audio & MIDI Settings 
(standalone mode only)?
Have you turned the main Reaktor volume slider down by accident?
Have you summed a phase inverted signal to Mono? Keep in mind that if you are 
soloing the side signals and don’t phase flip them using the POST-ENCODE 
method, the sides will cancel when summed to Mono.

Things are sounding ‘wrong’.

Are you sure you have the correct input mode setup? 
If your signal is standard Left Right signal coming in, be sure to use the LR>M/S 
mode input if you’re trying to do M/S processing and then set the Output Mode to 
STEREO.

Things are sounding distorted.

Is the Release time too low for the main Maximizer?
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Is the Release time set too low for the output Maximizer (found in the Output 
Settings)?
Are you getting red signal at the outputs? If so, have you activated the Output 
Limiter (LIMIT) to prevent overs?
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